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Copyright 
 
©  BIXOLON Co., Ltd. All rights reserved. 
   
This user manual and all property of the product are protected under copyright law. 
It is strictly prohibited to copy, store, and transmit the whole or any part of the manual and 
any property of the product without the prior written approval of BIXOLON Co., Ltd. 
The information contained herein is designed only for use with this BIXOLON product. 
BIXOLON is not responsible for any direct or indirect damages, arising from or related to 
use of this information. 
 
• The BIXOLON logo is the registered trademark of BIXOLON Co., Ltd. 
• All other brand or product names are trademarks of their respective companies or  

organizations. 
  
BIXOLON Co., Ltd. maintains ongoing efforts to enhance and upgrade the functions and  
quality of all our products. 
In the following, product specifications and/or user manual content may be changed 
without prior notice. 
 
 

Caution 
 
Some semiconductor devices are easily damaged by static electricity. You should turn the 
printer “OFF”, before you connect or remove the cables on the rear side, in order to guard 
the printer against the static electricity. If the printer is damaged by the static electricity, 
you should turn the printer “OFF”. 
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Introduction 
 
This Windows Driver Manual provides information on installation, detailed specifications, 
and usage of the printer’s Windows Driver according to PC operating system (OS). 
 
It is advisable to read the contents of this manual carefully before using the Windows 
Driver for the first time. 
 
 

Manual Symbols Information  

  It provides additional information on the function and performance  
of the product. 
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1. Operating System (OS) Environment                                                
 
The following operating systems are supported for usage. 
 
Microsoft Windows 7 (32bit/64bit) 
Microsoft Windows 8 (32bit/64bit) 
Microsoft Windows 8.1 (32bit/64bit) 
Microsoft Windows 10 (32bit/64bit) 
Microsoft Windows 11 (64bit/ARM) 
Microsoft Windows Server 2008 (32bit/64bit) 
Microsoft Windows Server 2008R2 (64bit) 
Microsoft Windows Server 2012/2012R2 (64bit) 
Microsoft Windows Server 2016 (64bit) 
Microsoft Windows Server 2019 (64bit) 
 

 

- Serial and Parallel printer port do not work on Windows 10 version 1511 
(OS Build 105860.104) specific. We recommend you to install the latest  
Windows 10 update through Windows Update before installing Windows  
Driver. 

- You can download and install the Windows Update in the Update &  
security tab of the Settings menu. 
(  > Settings > Update & security > Windows Update). 
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2. Supported Printers                                   
 
This manual provides information for the following printer drivers. 
 

Models Resolution 
SRP-Q300/QE300/E300 

SRP-380/380plus 
SRP-350III/350plusIII/350V/350plusV 

SRP-F310II 
SRP-330/330II/330III 

SRP-B300II 
BGT-100P 

180 DPI 

SRP-Q200 
SRP-Q302/QE302/E302/Q300II 

SRP-382/382plus 
SRP-S300/S320/S3000/S200/S300II 

SRP-352III/352plusIII/352V/352plusV 
SRP-F312II/F313II 
SRP-332II/332III 

BGT-102P 
BK3-3 
BK3-2 

BK5-3/BK5-4 
SRP-B300 
SPP-200 

G30 
SRP-G300 
SPP-300 

203 DPI 

SRP-383 300 DPI 
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3. Windows Driver Preparation                                                
 
The Windows Driver the latest file version can be downloaded from BIXOLON website. 
(www.bixolon.com)   

http://www.bixolon.com/
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4. Windows Driver Installation                                                    
 
4-1 Installation 
 
1) Double-click “Software_[Model name]_Windows_Driver_Vx.x.x.exe”. 
 
2) The Network Auto Installation function allows you to install drivers for the same  

network printer. Before using the function, the IP address of the printer must be set,  
  so download the Net Configuration Tool from our website and set the IP address first. 
 

 

- Administrator privilege may be required to run the installation file.  
- In case of the printer’s IP address is invalid or the printer is 
communicating with another application, etc., the printer cannot be 
searched through the Network Auto Installation function. 

- Supported Models for Network auto installation 
SRP-Q300/Q302/QE300/QE302/Q300II, SRP-380/382/383/380plus/382plus,  
SRP-S300/S320/S3000/S200/S300II, SRP-350III/352III, 
SRP-350plusIII/352plusIII,  
SRP-F310II/F312II/F313II, SRP-B300, BK3-3, 
SRP-330II/332II/330III/332III, SRP-E300, G30 

 
3) Follow the instructions on the screen to complete the installation process. 
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4-2 Uninstallation 
 
1) Open "Add or Remove Programs" or "Remove Programs" in the Control Panel. 

* XP or Server 2003: Control Panel – Add or Remove Programs 
* Vista or higher OS: Control Panel – Remove Programs 
 

2) Double-click "BIXOLON [Model name] Windows Driver" to uninstall the installed  
windows drivers. 
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5. Windows Driver Settings                                                
 
The following functions can be configured after installing the Windows driver. 
 
5-1 Layout 
 

  
 

1) Open the Printer Properties window and then click Printing Preferences in the  
General tab. 

 

 

Please refer to below paths of Printer Properties window. 
* Windows 7 / 8 / 10 / Server 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) – (Click Printer 
Properties) 

 
2) Click the Layout tab. 
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5-1-1 Paper Size 
 
Paper size of 80 x 3276 mm (2inch printer is 58 x 3276 mm) is selected by default, and the 
following sizes can be selected.  
 

Models Paper sizes can be selected 
SRP-Q200 

BK3-2 
SRP-S200 

58  297 mm 58  3276 mm A4 210  297 mm 
 

SRP-Q300/Q302 
SRP- Q300II 

SRP-QE300/QE302 
SRP-E300/E302 

SRP-380/382/383 
SRP-380plus /382plus 

SRP-350III/352III 
SRP-350V/352V 

SRP-350plusIII/352plusIII 
SRP-350plusV/352plusV 

SRP-F310II/F312II 
SRP-330/330II/332II 

SRP-330III/332III 
BGT-100P/102P 

BK3-3, BK5-3 
SRP-B300/B300II 

SPP-200 
SRP-G300 
SPP-300 

80  297 mm 80  3276 mm A4 210  297 mm 
 

BK5-4 108  297 mm 1083276 mm A4 210  297 mm 
 

SRP-S300/S320/S3000/S300II,  
G30, SRP-F313II 

80 x 297 mm 80 x 3276 mm A4 210 x 297 mm 
83 x 297 mm 83 x 3276 mm  
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If a custom paper size is required, click “…” to add or update a custom paper size.  
 

 
 

Click Save after specifying the paper width/length and a paper name. If the specified 
paper name already exists on the system, you can update the paper width/length. 
 

Paper Width   : 25.4 mm (Min) ~ 210.0 mm (Max) 
Paper Length     : 25.4 mm (Min) ~ 3276.0 mm (Max) 
   

 
 

You can choose the new paper size on the Paper Size combo-box after adding a paper 
size. 
 

 
 

Delete button  : Deletes the paper size selected in the list. 
Save button    : Adds a new paper size or update the paper size selected in the  

     list if the paper name already exists on the system. 
 Base on Image Width : Choose whether to create based on the width of the image or  
       the width of the paper 
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5-1-2 Paper Type 
 
You can choose Receipt or Ticket as paper types.  
 

Receipt          : Receipt allows flexible paper length according to the data 
length. 

Ticket          : Ticket print in fixed length even the print data is short. 
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5-1-3 CPL Setting 
 
You can choose 48 CPL or 42 CPL Mode. 
In order to get a good print result, first proceed to CPL setup through the Bixolon Utility. 
 

 
 

 
Supported Models for CPL Setting 
SRP-B300 
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5-1-4 Copies 
 
Copies are printed by specifying the copy count. The copy count is set to 1 by default. Set 
this value bigger than 1 to set the number of copies to print. The value should be within 
the range of 1 to 255. 

 
5-1-5 Image Rotation 
 
Image rotation is available for image data only. It means that rotation of printer fonts 
(device fonts) or barcode fonts is not supported.  

 
5-1-6 Paper Reduction 
 
Reduction function reduces the size of the print image to save print paper. If this function 
is enabled and print-job data includes text data created by using a printer font (device font), 
printer fonts are converted to Windows fonts (True Type fonts) to make them smaller. The 
barcode size also can be reduced by selecting “Enable reducing barcode”. 
Using Pixel Interpolation feature, reduce print quality can be improve. But, because the 
Pixel Interpolation feature references value of near pixels, reducing dense images can be 
disadvantageous. 

 

 

- 32bit applications running on 64bit Windows cannot work for this feature. 
- It can affect barcode recognition, if the barcode size is reduced. 
Not Supported Models for Pixel Interpolation 
BGT-100P/102P, SRP-B300, BK3-3/2 
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5-1-7 Crop Function 
 
This function crops the upper and lower end of the printing area by the specified 
number. It helps reduce the margin at the top and bottom when there is excessive 
margin. The value should be within the range of 0 to 255. 

 

 
 

 

- “Margin Crop” is not affected by the figures. 
Not Supported Models for margin crop and left/right crop function 
BGT-100P/102P, SRP-330, SRP-B300, BK3-3/2 

 
 

5-1-8 Orientation 
 
Printing orientation can be set to Portrait (which is the default) or Landscape. It is not 
possible to use printer fonts (device fonts) and barcode fonts in landscape. 
 
Portrait : Printing in the vertical direction. 
Landscape: Printing in the horizontal direction.   
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5-2 Document Settings 
 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the 
 General tab. 

 

 

Please refer to below paths of Printer Properties window. 
* Windows 7 / 8 / 10 / Server 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items)  
– (Devices and Printers) – (Right-click the icon of the printer) –  
(Click Printer Properties) 

 
2) Click the Document Settings tab. 
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5-2-1 Send Command 
 
The Windows driver serves to receive the content for print from an application and send 
it to the printer. The “Send Commands” function allows for the addition of desired 
commands at the start or end of the print content. 
 
Start Doc : Addition of command at the beginning of the document. 
Start Page : Addition of command at the beginning of the page. 
End Page : Addition of command at the end of the page. 
End Doc : Addition of command at the end of the document. 

 

 
For more information about the hexadecimals, refer to the Commands 
Manual. 
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5-2-2 Cash Drawer/Internal Beep 
 
To open a cash-drawer before printing, tick “Open before printing #1” or “Open before 
printing #2”. 
 
To open a cash-drawer after printing, tick “Open after printing #1” or “Open after 
printing #2”. 
 
To make a beep sound when printing, tick “Beep sound before printing” or “Beep sound 
after printing”. 
 
To alarm on end of page or end of document, tik “Alarm on End Page” or “Alarm on End 
Doc”. 

 
 

 

Supported Models for Internal Beep  
SRP-Q300/Q302, SRP-QE300/QE302, SRP-Q300II, 
SRP-380/382/383/380plus/382plus,  
SRP-S300/S300II, SRP-S320, SRP-S3000, SRP-S200, 
SRP-350III/352III/350V/352V,  
SRP-350plusIII/352plusIII/350plusV/352plusV, 
SRP-F310II/F312II/F313II, 
SRP-330/330II/332II/330III/332III, BGT-100P/102P 
Supported Models for Alarm on End Page, Alarm on End Doc 
G30 
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5-2-3 Line Feed 
 
It is possible to set the number of line feeds between 0 and 99 for adding blank lines at 
the end of printing. 
 
5-2-4 Paper Cut 
 
Paper can be cut at the end of each page or each document (job). 
 
Page/Job: No Cut/No Cut : Paper is not cut after printing. 
Page/Job: No Cut/Partial Cut : Paper is cut at the end of each document (Job). 
Page/Job: Partial Cut/Partial Cut : Paper is cut at the end of each page. 
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5-3 NV Image 
 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the  
General tab. 

 

 

Please refer to below paths of Printer Properties window. 
* Windows 7 / 8 / 10 / Server 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) –  
(Click Printer Properties) 

 
2) Click the NV Image tab. 
 
The position to print NV image stored in the printer can be set at the beginning and/or 
end of the document and beginning and end of each page.  
 

 

There are two commands for NV Image printing. Take care of selecting one 
of the two commands because NV images cannot be printed depending on 
the selected command. 

NV bit image : FS p 
NV graphics : GS L 

 

 
Start Doc : Insert NV image at the top of the document. 
Start Page : Insert NV image at the top of the page. 
End Page : Insert NV image at the end of the page. 
End Doc : Insert NV image at the end of the document. 
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5-4 Barcode  

 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the  
General tab. 

 

 

Please refer to below paths of Printer Properties window. 
* Windows 7 / 8 / 10 / Server 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) –  
(Click Printer Properties) 

 
2) Click the Barcode tab. 
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5-4-1 1D Barcode 
 
Windows driver supports one-dimensional barcode fonts as shown in the following table. 
Barcodes can be printed on the printer by using following font names. 
 

Div. Font 
Name Symbology Supported 

Characters 
Size (Point) 

A B 180dpi 203dpi 300dpi 

O 

O 

Barcode1 UPC-A Numeric: 0~9 

20 
40 
60 
80 

18 
35.5 
53 
71 

12 
24 
36 
48 

Barcode2 UPC-E Numeric: 0~9 
Barcode3 JAN13 (EAN) Numeric: 0~9 
Barcode4 JAN8 (EAN) Numeric: 0~9 

 
Barcode5 Code39 

Numeric: 0~9 
Symbols: $, +, -, ., / 

Letters: A~Z 
Barcode6 ITF Numeric: 0~9 

 
Barcode7 Coda bar 

Numeric: 0~9 
Symbols: $, +, -, ., /, : 

Letters: A~D 
Barcode8 Code93 ASCII: 0x00 ~ 0x7F 
Barcode9 Code128 ASCII: 0x00 ~ 0x7F 

X 

Barcode10 GS1-128 Numeric: 0~9 

Barcode11 
GS1 Data Bar 

Omnidirection Numeric: 0~9 

Barcode12 GS1 Data Bar 
Truncated Numeric: 0~9 

Barcode13 GS1 Data Bar 
Limited Numeric: 0~9 

* O: Supported, X: Not Supported 
 

Division models 

A 

SRP-Q300/Q302, SRP-QE300/QE302, SRP-Q300II, 
SRP-380/382/383/380plus/382plus,  
SRP-S300/S320/S3000/S200/S300II, 
BK3-3, BK3-2, BK5-3, BK5-4, SPP-200, G30, SRP-G300 

B 

SRP-E300/E302, SRP-350III/352III/350V/352V, 
SRP-350plusIII/352plusIII/350plusV/352plusV, 
SRP-F310II/F312II/F313II, SRP-330/330II/332II/330III/332III, 
SRP-Q200, BGT-100P/102P, SRP-B300 
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If you want to change the default value of 1d barcode properties, select a Font Name and 
Type of one-dimensional barcode, and then click Properties. Click OK after changing the 
values of properties. 
 

 
   



Windows Driver 

Ver. 1.19 - 26 - 

5-4-2 2D Barcode 
 
Windows driver supports two-dimensional barcode fonts as shown in the following table. 
Barcodes can be printed on the printer by using following font names. 
 

 Div. 
Font Name Symbology 

Size (Point) 
A B C 180dpi 203dpi 300dpi 

O 
O 

O 
2D-Code1 PDF417 

9.5 8.5 6 
2D-Code2 QR Code 

X 
2D-Code3 DATAMATRIX Code 

X 
2D-Code4 GS1 Data Bar 
2D-Code5 Composite Symbology 

* O: Supported, X: Not Supported 
 

Division Supported models 

A 

SRP-Q300/Q302, SRP-QE300/QE302, SRP-Q300II, 
SRP-380/382/383/380plus/382plus,  
SRP-S300/S320/S3000/S200/S300II, 
BK3-3, BK3-2, BK5-3, BK5-4, SPP-200, G30, SRP-G300 

B 

SRP-E300/E302, SRP-350III/352III/350V/352V, 
SRP-350plusIII/352plusIII/350plusV/352plusV, 
SRP-F310II/F312II/F313II, SRP-330II/332II/330III/332III, SRP-Q200, 
BGT-100P/102P, SRP-B300/B300II 

C SRP-330 
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To change the default value of 2d barcode properties, select a Font Name and Type of 
two-dimensional barcode, and then click Properties. Click OK after changing the values of 
properties for 2d barcode. 
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5-5 Dithering 
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1) Open the Printer Properties window and then click Printing Preferences in the  
General tab. 

 

 

Please refer to below paths of Printer Properties window. 
* Windows 7 / 8 / 10 / Server 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) –  
(Click Printer Properties) 

 
2) Click the Dithering tab. 
 
This printer is a black and white printing device including dithering function, greyscale 
print function, and brightness level adjustment function to produce a sharper or softer 
image. The following dithering algorithms can be selected when Monochrome is 
selected. 
 

None 4x4 Matrix 
Error Diffusion 8x8 Matrix 
Ordered Dither  

 

 

Print speed may become slower if Greyscale is selected because of the 
large amount of data to send to the printer. 
 
Supported Models for Greyscale  
SRP-Q300/Q302, SRP-QE300/QE302, SRP-Q300II, 
SRP-380/382/383/380plus/382plus,  
SRP-S300/S320/S3000/S200/S300II, SRP-350III/352III/350V/352V,  
SRP-350plusIII/352plusIII/350plusV/352plusV, 
SRP-F310II/F312II/F313II, 
SRP-330/330II/332II/330III/332III,  
SRP-E300/E302, BGT-100P/102P, SRP-B300/B300II 
G30 
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2) Click the Advanced button. 
Each UI provides the following functions. 
 

• Color Threshold 

Applied when a color image is sent to the driver. Adjusting the threshold changes 
how colors are processed during printing. 
 

• Bold Line 

Makes the lines in the image appear thicker when printed. A higher value produces 
bolder lines. 
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5-6 Utility 
 

 
 

1) Open the Printer Properties window and then click Printing Preferences in the  
General tab. 

 

 

Please refer to below paths of Printer Properties window. 
* Windows 7 / 8 / 10 / Server 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) –  
(Click Printer Properties) 

 
2) Click the Utility tab. 
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5-6-1 Bixolon Utility 
 
Refer to the Bixolon Utility manual included in the CD for details. 
 
5-6-2 Special Font Edit Utility 
 
The purpose of FontControlA font is not for text printing. It is used to define the printer 
command, assign the defined printer command to a specific ASCII character, and send it 
to the printer. The range of ASCII code that the command can be assigned is from 0x20 
to 0x7F, and the command can be easily assigned using this utility. 
 
1) Click Special Font Edit. 
 
2) Select an ASCII code character and enter the print command. All values should be 
  entered in hexadecimal number format. 
 
3) Click Apply and then click OK.  
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5-6-3 Journal Viewer 
 

Journal is a function to save a copy of printed receipts. Copies can be saved without using 
journal printer with this function. Journal saves each printed document in a file and the 
saved file can be viewed by using this utility. 
  

1) Tick Enable Journal to run Journal Viewer, and then click Journal Viewer. 
 

 
 

2) Click Search to set search condition, and then enter Start Date and End Date. 
 

3) Click OK to search the files created within the specified period. 
 

 
 

4) Select the file to print from the list and click Print to send the data stored in the file to 
 the printer. 
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5-6-4 Text-Key Function 
 
Text-Key Function is a utility to replace specific text (Text-Key) with other texts or graphic 
images, and to add images to the bottom of receipts. This function can be used only 
when using printer fonts (device fonts). It has no effect when using Windows fonts (True 
Type fonts) or the data for Text-Key does not exist on a Print-Job.  
 

▶ How to replace Text-Key with other texts. 
 
1) Tick Enable Text-Key Function and then click Text-Key Function. 
 

 
 
2) Click Add New Key, type a text to be used as Text-Key, and then click OK.   
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3) If the Text-Key is selected, The Configuration button is enabled. 
 
4) Click Configuration to enter a text, which is used to replace the selected Text-Key with 

the text entered. For example, if you enter “APPLE” in the text box as below, the Text-
key, “POTATO” can be replaced with “APPLE”. 

 

 
 
▶ How to replace Text-Key with a graphic image and to add it to the bottom of receipts. 
 
1) This utility can also replace the selected Text-Key with a graphic image instead of texts 

and can add a graphic image to the bottom of receipts. It is necessary to add images to 
the image list. 

 
2) Click Add New Image to browse for an image to add to the list. 
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3) Enter a unique name to be added, adjust the brightness, select a dithering type, and 
then click OK. Repeat 2 to 3 step to add up to as much as you want.  
 

 
 

 
 

4) Select a Text-Key in the Text-Key list, and then click Configuration.    
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5) To replace the selected Text-Key with a graphic image, select one of the available 
identifier via the combo box under “Replacement” label. There are two replacement 
functions but only one of the two is available.  

 

 
 

 
 

6) In order to print a graphic image to the bottom of receipts, select one of the available 
identifier via the combo box under “Adding a image to the bottom of receipts” label. 
The graphic image for the selected identifier only will be printed if the data for the 
selected Text-Key were found on a Print-Job. 
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5-6-5 Print Preview 
 
This application with a preview of a print-job runs, and windows driver does not directly 
send print-job data to the printer when enabled by clicking “Enable Print Preview”. 
Print-job data can only be sent to the printer in the application.  
 

 
The actual output of preview image processed by the application might look 
a little different. 

 
1) Tick Enable Print Preview to make Windows Driver ready for running the application. 
 

 
 

2) When print-job data are created via Windows Driver, the application runs, and then 
loads the data to draw the expected output on screen.   
 

3) Click Print if you want to print, or click Close to exit the application.  
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5-6-6 Font Replacement 
 
Font Replacement function is a utility to replace Windows fonts (True Type fonts) to 
printer fonts (device fonts) in Print-Job data.  
It has no effect if no include Windows fonts in Print-Job data. In order to Windows fonts 
replace to double-byte printer fonts, you should download double-byte printer font to 
printer through the Bixolon Utility. 
 
▶ How to replace Windows fonts (True Type font) to other printer fonts (device fonts). 
 
1) Tick Enable Font Replacement Function and then click Font Replacement Function 
 

 
 
2) Select Windows font (True Type font) and Set printer font (device font) 
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3) You can also find Windows font (True Type font) in the list via typing Windows font 
(True Type font) name. This feature is not case sensitive. 

 

 
 
4) You can replace all Windows font (True Type font) to printer font (device font)  

in Print-Job data via check Replacing all True Type Font. 
 

 
 
5) If finish setting, Click Save. 
 

 
Not Supported Models  
BGT-100P/102P, BK3-3/2 
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5-6-7 Printer Status Email Notification 
 
The Printer Status Email Notification is a utility that sends alarms to a designated email 
address or desktop notification when an abnormal status is detected. 
 

 

Minimum System Requirements 

Supported OS: Windows 10, Windows 11 
DirectX Version: DirectX 11.1 or higher with Driver Feature Level 11_0 or 
above 

 
1) Search Driver 

- It scans for installed printer drivers. If the Monitoring button is enabled, it allows the 
system to monitor the status of printers connected through the driver. 

 

 
 

 
To enable Monitoring, go to Driver Properties > Ports and enable the 
Bidirectional Support option.  
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2) Status Check Settings 
- Desktop Alarm: When an abnormal status occurs, a notification will appear in the 

bottom-right corner of the desktop. 
- E-mail Alarm: When an abnormal status occurs, an alarm message will be sent to the 

e-mail address provided in the settings. 
- Cash Drawer Opening Settings: The status of "Cash Drawer Open" is based on the 

printer’s cash drawer setting. 
- Status List on the Right: Alarms are sent only for the specific status conditions 

selected by the user. 
 

 
 
 
 
 
 
 
 
 
 
 
 



Windows Driver 

Ver. 1.19 - 43 - 

3) E-mail Settings 
- Load: Imports e-mail settings from a saved file and applies them to the current email 

settings. 
- Save: Saves the e-mail settings as an encrypted file. 
- + Driver Name: Adds the name of the driver with the abnormal status to the email 

message. 
- + Driver Status: Adds the specific status of the driver to the e-mail message. 
- Test Mail: Sends a test e-mail using the information specified by the user. 
- SMTP Server, SMTP Authentication, Port, Login ID, Password: Enter the SMTP 

server settings for the outgoing email server. 
 

 

※ Password 
Make sure to enter the password required by the outgoing email server 
(e.g., Gmail, Yahoo, etc.). 
For Gmail, two-step verification and an app password are required. 
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▶ Setting Up Gmail STMP Password 
 
1) Go to Google -> Account -> Security. 
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2) 2-Step Verification -> Turn on 2-Step Verification 

 

 
 
3) Enter "App passwords" into the search bar. 
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4) Enter an app name, then select Create. 

 
 
5) Check the generated app password. 
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6) Go to E-mail Settings -> Password, then enter the Gmail app password. 
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5-7 Bidirectional Communication 
 

 
 

1) Open the Printer Properties window. 
 

 

Please refer to below paths of Printer Properties window. 
* Windows 7 / 8 / 10 / Server 
(Control Panel) – (Hardware and Sound) or (All Control Panel Items) – 
(Devices and Printers) – (Right-click the icon of the printer) –  
(Click Printer Properties) 

 
2) Click Ports tab.    
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Because “bidirectional support” is disabled by default, it is necessary to tick Enable 
bidirectional support to get status from the printer. Sample codes can help you get more 
status information than the status information that OS supplies as standard way. This 
windows driver supports only one-on-one communication between the printer and host 
(typically a PC). 
 

Supported Models Printer status that  
OS supports 

Printer status that  
OS does not support 

SRP-Q300/Q302 
SRP-Q300II 

- ONLINE/OFFLINE 
- COVER OPEN/CLOSE 
- PAPER EMPTY 

- CASH DRAWER  
OPEN/CLOSE 

- BATTERY 
 NORMAL/LOW 

SRP-Q200 
SRP-QE300/QE302 

SRP-330 

- ONLINE/OFFLINE 
- COVER OPEN/CLOSE 
- PAPER EMPTY 

CASH DRAWER 
OPEN/CLOSE 

SRP-E300/E302 
SRP-B300 

- ONLINE/OFFLINE 
- PAPER EMPTY 

CASH DRAWER 
OPEN/CLOSE 

SRP-380/382/383/380plus/382plus 
SRP-S300/S320/S3000/S200/S300II 

SRP-350III/352III 
SRP-350V/352V 

SRP-350plusIII/352plusIII 
SRP-350plusV/352plusV 

SRP-F310II/F312II/F313II 
SRP-330II/332II/330III/332III 

BGT-100P/102P 
G30 

- ONLINE/OFFLINE 
- COVER OPEN/CLOSE 
- PAPER EMPTY 

- NEAR END PAPER 
- CASH DRAWER 

OPEN/CLOSE 

BK3-3 
BK3-2 
BK5-3 

SPP-200 

- ONLINE/OFFLINE 
- PAPER EMPTY NEAR END PAPER 
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6. Windows Driver Specification                                                
 
6-1 Printer Fonts 
• This Windows driver supports various printer fonts (device fonts) in the following table.  

Printing using these fonts is faster than using Windows fonts provided by the  
operating system. 

 
• 180/203 DPI Models 

Printer Font Name Size (Dot) 
Size (Point) 

180 dpi 203 dpi 
FontA1x1 FontA1x1[Ext.] FontA1x1[255] 12x24 9.5 8.5 
FontA1x2 FontA1x2[Ext.] FontA1x2[255] 12x48 19 17 
FontA2x1 FontA2x1[Ext.] FontA2x1[255] 24x24 9.5 8.5 
FontA2x2 FontA2x2[Ext.] FontA2x2[255] 24x48 19 17 
FontA2x4 FontA2x4[Ext.] FontA2x4[255] 24x96 38.5 34 
FontA4x2 FontA4x2[Ext.] FontA4x2[255] 48x48 19 17 
FontA4x4 FontA4x4[Ext.] FontA4x4[255] 48x96 38.5 34 
FontA4x8 FontA4x8[Ext.] FontA4x8[255] 48x192 77 68 
FontA8x4 FontA8x4[Ext.] FontA8x4[255] 96x96 38.5 34 
FontA8x8 FontA8x8[Ext.] FontA8x8[255] 96x192 77 68 
FontB1x1 FontB1x1[Ext.] FontB1x1[255] 9x17 7 6 
FontB1x2 FontB1x2[Ext.] FontB1x2[255] 9x34 13.5 12 
FontB2x1 FontB2x1[Ext.] FontB2x1[255] 18x17 7 6 
FontB2x2 FontB2x2[Ext.] FontB2x2[255] 18x34 13.5 12 
FontB2x4 FontB2x4[Ext.] FontB2x4[255] 18x68 27 24 
FontB4x2 FontB4x2[Ext.] FontB4x2[255] 36x34 13.5 12 
FontB4x4 FontB4x4[Ext.] FontB4x4[255] 36x68 27 24 
FontB4x8 FontB4x8[Ext.] FontB4x8[255] 36x136 54.5 48.5 
FontB8x4 FontB8x4[Ext.] FontB8x4[255] 72x68 27 24 
FontB8x8 FontB8x8[Ext.] FontB8x8[255] 72x136 54.5 48.5 
FontC1x1 FontC1x1[Ext.] FontC1x1[255] 9x24 9.5 8.5 
FontC1x2 FontC1x2[Ext.] FontC1x2[255] 9x48 19 17 
FontC2x1 FontC2x1[Ext.] FontC2x1[255] 18x24 9.5 8.5 
FontC2x2 FontC2x2[Ext.] FontC2x2[255] 18x48 19 17 
FontC2x4 FontC2x4[Ext.] FontC2x4[255] 18x96 38.5 34 
FontC4x2 FontC4x2[Ext.] FontC4x2[255] 36x48 19 17 
FontC4x4 FontC4x4[Ext.] FontC4x4[255] 36x96 38.5 34 
FontC4x8 FontC4x8[Ext.] FontC4x8[255] 36x192 77 68 
FontC8x4 FontC8x4[Ext.] FontC8x4[255] 72x96 38.5 34 
FontC8x8 FontC8x8[Ext.] FontC8x8[255] 72x192 77 68 
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• 300 DPI Models 

Printer Font Name Size (Dot) 
Size (Point) 

300 dpi 
FontA1x1 FontA1x1[Ext.] FontA1x1[255] 18x34 8 
FontA1x2 FontA1x2[Ext.] FontA1x2[255] 18x68 16.5 
FontA2x1 FontA2x1[Ext.] FontA2x1[255] 36x34 8 
FontA2x2 FontA2x2[Ext.] FontA2x2[255] 36x68 16.5 
FontA2x4 FontA2x4[Ext.] FontA2x4[255] 36x136 32.5 
FontA4x2 FontA4x2[Ext.] FontA4x2[255] 72x68 16.5 
FontA4x4 FontA4x4[Ext.] FontA4x4[255] 72x136 32.5 
FontA4x8 FontA4x8[Ext.] FontA4x8[255] 72x272 65.5 
FontA8x4 FontA8x4[Ext.] FontA8x4[255] 144x136 32.5 
FontA8x8 FontA8x8[Ext.] FontA8x8[255] 144x272 65.5 
FontB1x1 FontB1x1[Ext.] FontB1x1[255] 12x24 6 
FontB1x2 FontB1x2[Ext.] FontB1x2[255] 12x48 11.5 
FontB2x1 FontB2x1[Ext.] FontB2x1[255] 24x24 6 
FontB2x2 FontB2x2[Ext.] FontB2x2[255] 24x48 11.5 
FontB2x4 FontB2x4[Ext.] FontB2x4[255] 24x96 23 
FontB4x2 FontB4x2[Ext.] FontB4x2[255] 48x48 11.5 
FontB4x4 FontB4x4[Ext.] FontB4x4[255] 48x96 23 
FontB4x8 FontB4x8[Ext.] FontB4x8[255] 48x192 46 
FontB8x4 FontB8x4[Ext.] FontB8x4[255] 96x96 23 
FontB8x8 FontB8x8[Ext.] FontB8x8[255] 96x192 46 
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Printer Fonts are defined as follows. 
 
1) FontA1x2 (Double height) 
- ANSI Character code support (Code Page 1252) 
- Font size (Dot): 12 x 48 (180/203dpi), 18 x 68 (300dpi) 
- Font size (Point): 19 (180 dpi) 
- Font size (Point): 17 (203 dpi) 
- Font size (Point): 16.5 (300dpi) 

 
2) FontA1x2[Ext.] (Double height) 
- IBM expansion Character code support (Code Page 437)  
- Font size (Dot): 12 x 48 (180/203dpi), 18 x 68 (300dpi) 
- Font size (Point): 19 (180 dpi) 
- Font size (Point): 17 (203 dpi) 
- Font size (Point): 16.5 (300dpi) 

 
3) FontA1x2[255] (Double height) 
- Buyer exclusive code support (User Code page)  
- Font size (Dot): 12 x 48 (180/203dpi), 18 x 68 (300dpi) 
- Font size (Point): 19 (180 dpi) 
- Font size (Point): 17 (203 dpi) 
- Font size (Point): 16.5 (300dpi) 
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6-2 Special functions 
• This Windows driver supports the special functions as shown in the following table. 

Select Font Control font first and use the characters in the table to use the special  
functions.  

 

 

Take care as this function is not for printing general texts. 
Character 8 function (Presenter Paper Eject)  
only works with BK3-3 Presenter Model. 

 
Character Special Function 

5 Prints HT (0 x 09) 
6 Prints LF (0 x 0A) 
7 Prints CR (0 x 0D) 
8 Presenter Paper Eject 
a Open Drawer 2 (50ms pulse width) 
b Open Drawer 2 (100ms pulse width) 
c Open Drawer 2 (150ms pulse width) 
d Open Drawer 2 (200ms pulse width) 
e Open Drawer 2 (250ms pulse width) 
f Open Drawer 2 without paper feeding (50ms pulse width) 
g Cut Receipt (Partial cut) without paper feeding 
i Prints the NV Image (FS p) saved in the 00 address (double-size) 
j Prints the NV Image (FS p) saved in the 01 address (double-size) 
k Prints the NV Image (FS p) saved in the 02 address (double-size) 
l Prints the NV Image (FS p) saved in the 03 address (double-size) 

m Prints the NV Image (FS p) saved in the 04 address (double-size) 
p Does not add HRI characters to the barcode 
q Adds HRI characters in Font A above the barcode 
r Adds HRI characters in Font A below the barcode 
s Adds HRI characters in Font B above the barcode 
t Adds HRI characters in Font B below the barcode 
u Turns white/black reverse printing mode on 
v Turns white/black reverse printing mode off 
w Aligns text to the left 
x Aligns text to the center 
y Aligns text to the right 
A Open Drawer 1 (50ms pulse width) 
B Open Drawer 1 (100ms pulse width) 
C Open Drawer 1 (150ms pulse width) 
D Open Drawer 1 (200ms pulse width) 
E Open Drawer 1 (250ms pulse width) 
F Open Drawer 1 without paper feeding (50ms pulse width) 
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G Prints the NV bit map (GS (L) saved in the 00 address 
H Prints the NV bit map (GS (L) saved in the 01 address 
I Prints the NV bit map (GS (L) saved in the 02 address 
J Prints the NV bit map (GS (L) saved in the 03 address 
K Prints the NV bit map (GS (L) saved in the 04 address 
P Cut Receipt (Partial cut) 
R Prints the NV Image (FS p) saved in the 00 address 
S Prints the NV Image (FS p) saved in the 01 address 
T Prints the NV Image (FS p) saved in the 02 address 
U Prints the NV Image (FS p) saved in the 03 address 
V Prints the NV Image (FS p) saved in the 04 address 
[ Prints the NV bit map (GS (L) saved in the 00 address (double-size) 
] Prints the NV bit map (GS (L) saved in the 01 address (double-size) 
^ Prints the NV bit map (GS (L) saved in the 02 address (double-size) 
_ Prints the NV bit map (GS (L) saved in the 03 address (double-size) 
` Prints the NV bit map (GS (L) saved in the 04 address (double-size) 

 
1) Example 
 
Select Font Control font and send 6 for “LF” (Line Feed) operation (instead of printing 
character “6”).  
 
2) Font Control font functions. 
 

Font Name Special Functions 
Size (Point) 

180 dpi 203 dpi 300dpi 

Font Control 

Open Drawer #1/# 2 
Cut Receipt 

Cut receipt (without paper feeding) 
Justification (Left/Center/Right) 

Output HT, Output LF, Output CR, 
Print NV Image 

9.5 8.5 6 
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7. Use of Windows Driver                                                
 
Sample codes are installed “C:\BIXOLON\POS Windows Driver\Sample”, when the driver 
install. 
 

 
If Windows was installed at “D” drive, the sample codes are installed “D” 
drive. 

 
7-1 Use of Visual Basic 
• This section contains example codes to control the printer using Windows driver with  

Visual Basic.  
 
7-1-1 Windows Driver Selection 
 
When you select the printer driver, please designate a device name by the printer name. 
The following example code explains how to select “BIXOLON SRP-350III” Windows 
driver. 
 
For Each prnPrinter In Printers 
 
If prnPrinter.DeviceName = “BIXOLON SRP-350III” Then 
 
Set Printer = prnPrinter 
 
Exit For 
 
End If 
 
Next 
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7-1-2 Text Printing 
 
The following example code explains how to print texts using Windows fonts and printer 
fonts (device fonts). 
 
‘Print in Windows font 
Printer.FontSize = 9 
Printer.FontName = “Arial” 
Printer.Print “Arial Test”  
 
‘Print in printer font 
Printer.FontSize = 9.5 
Printer.FontName = “FontA1x1” 
Printer.Print “FontA1x1 Font”  
 
Printer.EndDoc 

 
7-1-3 Barcode Printing  
 
The following example code explains how to print the barcode (JAN8 (EAN)). 
 
'Print Bar Code. 
Printer.FontSize = 20 
 
Printer.FontName = "Barcode4" 
Printer.Print "1234567" 
 
Printer.EndDoc 

 
The following example code explains how to print the 2D barcode (PDF417). 
 
'Print Two-dimensional Codes. 
Printer.FontSize = 9.5 
 
Printer.FontName = "2D-Code1" 
Printer.Print "Print Test PDF417" 
 
Printer.EndDoc 
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7-2 Use of WordPad 
 
7-2-1 WordPad Environment Settings 
 
Launch WordPad, set the printing related options as follows, and test the printer with 
WordPad. 
 
- Select printer 
Select “Print” from the “File” menu, and select the BIXOLON printer. 
 
- Set paper size, orientation, margin, etc. 
Select the “Page Setting” from “File” menu, and set paper size, orientation, and margin. 
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7-2-2 Text Printing 
 
Use the printer's Windows driver to output text. 
 

 
 
1) Select the font from the font selection box (FontA1x1). 
 
2) Select the point size from the point selection box (180 DPI: 9.5, 203 DPI: 8.5). 
 
3) Enter the text to print. 
 
4) Click the Print icon in the toolbar to print the text. 
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Revision history 
 

Ver. Date Description 
1.00 13-03-2018 New 
1.01 04-09-2018 SRP-330, SRP-383 Added 
1.02 23-10-2018 BK3-3 Added 
1.03 08-03-2019 SRP-Q200 Added 
1.04 03-12-2019 BK3-2, BK3-3 Accessory Font Control Added 
1.05 15-01-2020 Pixel Interpolation, Font Replacement Added 

1.06 20-05-2020 Network Auto Installation Added 
Sample program install path changed 

1.07 16-09-2020 Supported OS Update, SRP-S320 Added 
1.08 11-10-2020 SRP-S3000 Added 
1.09 26-02-2021 SRP-B300, SRP-S200 Added 

1.10 15-06-2022 SRP-330III/332III, SRP-350V/352V, 
SRP-350plusV/352plusV Added 

1.11 30-08-2022 SRP-380II/382II Added 
1.12 14-04-2023 BK5-3, G30, SPP-200 Added 
1.13 16-10-2023 SRP-Q300II Added 
1.14 03-06-2024 SRP-S300II Added 

1.15 26-12-2024 
SRP-380II/382II -> SRP-380plus/382plus Change model name 

SRP-G300 Added 
Added margin crop of the crop function 

1.16 31-03-2025 BK5-4 Added 
Added 'Base on Image Width' function 

1.17 05-06-2025 SRP-B300II Added 

1.18 10-07-2025 Added Driver Status Email Notification Feature 
Unified POS Utility -> Bixolon Utility Changed 

1.19 11-11-2025 SPP-300 Added 
Dither Advanced UI Added 
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